Using Technology to Administer
Provincial Achievement Tests and Diploma Exams
Contents

Acknowledgements ............................................................................................................................................ 1
Overview .......................................................................................................................................................... 2
  General Guidelines ...................................................................................................................................... 2
OPTIONS FOR TECHNOLOGY TO WRITE PROVINCIAL ASSESSMENTS ............................................. 3
  Microsoft Word .......................................................................................................................................... 4
  Google Docs ............................................................................................................................................. 4
  Quest A+ .................................................................................................................................................. 4
  Learning Management Systems ..................................................................................................................... 5
CONTACTS .................................................................................................................................................... 5
APPENDIX: SAMPLE SECURE GOOGLE EXAM CONFIGURATION FOR CHROMEBOOKS ....................... 6
  Step 1: Create Exam OU and User Settings ................................................................................................. 6
  Step 2: Create Exam Template ................................................................................................................... 8
  Step 3: Create Exam Users and Apply to Exam OU ..................................................................................... 9
  Step 4: Set up Google Cloud Printers Via Print Server Application ......................................................... 9
  Step 5: Add a Custom App to Block the Research Pane ........................................................................... 10
Acknowledgements

In response to feedback from school authorities, Alberta Education’s Examination Administration Branch and Technology Leadership Branch co-hosted a focus group on March 2, 2016, to discuss alternative approaches for administering the Part A Written Response portion of Provincial Achievement Tests and Diploma Exams digitally in Chromebook environments, without the use of the Quest A+ Application. In attendance were representatives from Chinook’s Edge, Wildrose, Red Deer Public, Edmonton Public, Calgary Catholic and Buffalo Trail. These school authorities were instrumental in developing an example of a clear process that Alberta school authorities can use to ensure that students can securely use Chromebooks to write both Provincial Achievement Tests and Diploma Exams.

Alberta Education would like to express its appreciation to Myles Doupe from Chinook’s Edge School Division, who stepped forward to find a solution to an outstanding issue in the process that was developed. Myles wrote an extension to Chrome to resolve the issue.

Alberta Education would like to thank the Jurisdictional Technology Contacts and each of the school authorities that participated in this collaborative effort. We will continue to explore effective ways to use technology to write provincial assessments and look forward to further opportunities to work together to best meet the needs of our students. This document will continue to evolve over time and additional examples will be added as appropriate.
Using Technology To Write Provincial Assessments

Overview

Alberta Education is committed to supporting school authorities to administer provincial assessments using technology so students are given every opportunity to succeed. Currently, all Part A Written Response portions of Provincial Achievement Tests (PATs) and Diploma Exams can be administered using technology. The purpose of this document is to provide examples that can be used to assist schools and school authorities with IT decisions given their unique local environments (i.e. computing platform, type and number of devices, exam administration requirements, etc.).

It should be noted that, for examples presented in this document, exam security is achieved through a combination of various technical measures as well as vigilant proctoring. While most technical options currently make it possible to adhere to provincial exam rules and directives, it cannot be assumed that network configurations and account permissions can eliminate the need for human supervision. It is important to keep in mind that for pencil and paper exams, direct student supervision is still the primary security measure. For that reason, in the absence of technical measures, vigilant proctoring in and of itself is still an acceptable alternative – albeit more challenging when monitoring on-screen activities in a classroom environment with a large number of students.

General Guidelines

Any solution that would enable students to use technology for written response provincial assessments must incorporate these functions.

- Students can respond to up to 3 written response questions.
- Students can access all permitted word processing tools including:
  - a text editor which supports formatting, including either rich text or html editors;
  - spell check in Canadian English and French.
- Functions that are not permitted, such as grammar check, autocorrect and predictive word search must be disabled.
- In the event of a device or power failure, student responses must be saved in a way that is recoverable by exam supervisors. However, students cannot be permitted to save their responses to locations that can be accessed after the exam administration.
- Students cannot use functionality that would contravene exam administration rules, such as Internet access, sharing documents, communicating with others, online queries, and accessing previously saved work.
- At any time during the exam administration, either the student or supervisor can print student responses.
Options for Using Technology To Administer Provincial Assessments

Using Technology for Provincial Assessments

- Machine Scored Assessments
  - Quest A+
- Written Response Assessments
  - Learning Management Systems
    - Moodle
    - Desire 2 Learn
- Word Processor
  - Microsoft Word
  - Google Docs

Legend

- Can only be implemented on PCs and Macs
- Can be implemented on Chrome OS devices but not on PCs, Macs or student owned devices
- Can be implemented on PCs, Macs, Chrome OS devices and student owned devices
Microsoft Word

Microsoft Word is a widely used tool to administer written response provincial assessments. Prior to the exam administration, the functionality of PC or Mac devices are configured to comply with exam administration rules and directives. After the administration of the provincial assessment, school authority personnel are expected to delete all student responses from local servers or drives.

Google Docs

Chrome OS devices are widely used in many schools. When properly configured, school-owned Chrome OS devices and Google Docs can be used by students for Part A Written Response PATs and Diploma Exams.

Since Google Docs is developed by Google, modifications to the product could be made at any time. In the event that a modification to Google Docs is made that impacts the administration of Part A Written Response PATs and Diploma Exams, school authorities are encouraged to contact Alberta Education for guidance.

For more information on how to configure Chrome OS devices with Google Docs to administer Part A Written Response PATs and Diploma Exams, please see Appendix.

Quest A+

Unlike other solutions presented in this document which apply only to administering Part A Written Response assessments, Quest A+ serves multiple purposes. In addition to word processing, it is also used for machine-scored PATs, Diploma Exam perusals and other supporting processes such as practice tests and field testing of PATs and Diploma Exams.

Quest A+ enables secure online exam administration on both student and school-owned PC and Mac OS devices. Once a secure exam is started, its associated locked browser does not permit students to exit the test environment. School-owned Chrome OS devices can also be securely supported through configurations made in the Google Admin Console. To help ensure the reliability and stability of the application and to help ensure students using Quest A+ have a successful experience, **Quest A+ capacity** has been set to 4,300 simultaneous users for PATs and 4,000 simultaneous users for Diploma Exams.
Learning Management Systems

Learning Management Systems (LMS) like Moodle and Desire2Learn often have a built-in ability to administer Part A Written Response assessments. A LMS can then be configured to administer these assessments securely on Chrome OS devices, PCs and Macs.

Securing Chrome OS devices on an LMS

A LMS can be secured on Chrome OS devices using Public Sessions or kiosk apps. A kiosk app for Moodle can be made using the document provided online.

Securing PCs and Macs on an LMS

A LMS can be secured on PCs and Macs through a locked browser. Several third party software providers can provide locked browsers including Respondus and Proctorio. Safe Exam Browser is a free locked browser provider configurable for any digital exam.

Contacts

For assistance or clarifications, please contact

Pascal Couture
Team Leader, Digital Systems and Services
Provincial Assessment Sector
Phone 780-492-1462
Email: Pascal.Couture@gov.ab.ca
Appendix: Sample Secure Google Exam Configuration for Chromebooks

A special acknowledgement is extended to Buffalo Trail Public Schools Regional Division, Chinook’s Edge School Division, and Red Deer Public School District for contributing to the development of the following configuration.

The following steps were created for devices within a specific school authority environment. This is provided as a helpful example of how Google Chromebooks can be configured to meet Provincial Achievement Test and Diploma Exam administration requirements.

Additional suggestions on how to configure Google Chromebooks are welcome. Please contact Pascal.Couture@gov.ab.ca.

STEP 1: Create Exam Organizational Unit (OU) and User Settings

- **Create an OU for exam users.**
- **Device Management->Chrome Management->User Settings**
  - Select the OU where Exam Users are held from the left panel
  - Wallpaper > Upload Wallpaper > Use Secure Exam jpg
  - Avatar > Upload Avatar > Use Secure Exam Avatar jpg
  - Allowed Types of Apps > Uncheck all but Extension
  - Force-installed Apps and Extensions > Google Docs, Google Dictionary, and [Hide Google Docs Research](https://docs.google.com/document/d/1FOFVh5oWt7mvTKrheUGjG0kFoyFrMfWPeHE9xEmPw8/copy)
  - Allow or Block All Apps and Extensions > Select “Block all apps and extensions except the ones I allow”
  - Allowed Apps and Extensions > Google Docs, Hide Google Docs Research, Google Dictionary
  - Password Manager > Never allow use of password manager
  - Screen Lock > Never automatically lock screen on idle
  - Incognito Mode > Disallow incognito mode
  - Home Button > Always show Home button
  - Homepage > Homepage is always the Homepage URL, set below
    - [https://docs.google.com/document/d/1FOFVh5oWt7mvTKrheUGjG0kFoyFrMfWPeHE9xEmPw8/copy](https://docs.google.com/document/d/1FOFVh5oWt7mvTKrheUGjG0kFoyFrMfWPeHE9xEmPw8/copy)
  - Pages to Load on Startup
    - [https://docs.google.com/document/d/1FOFVh5oWt7mvTKrheUGjG0kFoyFrMfWPeHE9xEmPw8/copy](https://docs.google.com/document/d/1FOFVh5oWt7mvTKrheUGjG0kFoyFrMfWPeHE9xEmPw8/copy)
  - Screenshot > Disable Screenshot
  - Pop-ups > Allow all pop-ups
  - URL Blocking URL Blacklist:
    - *
    - [https://docs.google.com/document/u/0/?showDriveBanner=true#](https://docs.google.com/document/u/0/?showDriveBanner=true#)
- https://docs.google.com/document/u/0/?ftv=1
- https://docs.google.com/spreadsheets/d
- https://docs.google.com/presentation/d
- https://docs.google.com/drawings/d
- https://docs.google.com/a/rdpsd.ab.ca/presentation/
- https://docs.google.com/a/rdpsd.ab.ca/drawings/
- https://docs.google.com/a/rdpsd.ab.ca/spreadsheets/
- https://docs.google.com/a/rdpsd.ab.ca/forms/d/
- https://docs.google.com/forms/d/
- https://accounts.google.com/logout

- Must blacklist these specifically even though * is blocked.
- URL Blacklist Exception
  - chrome://print
  - https://drive.google.com/drive/shared-with-me
  - https://drive.google.com/drive/
  - https://drive.google.com/drive/my-drive
  - https://docs.google.com/a/rdpsd.ab.ca
  - https://docs.google.com/document/d
  - https://docs.google.com/document/u/0/

- Managed Bookmarks
  - https://drive.google.com/drive/my-drive  [Name: Exam Recovery]
- Bookmark Bar > Enable Bookmark Bar
- Bookmark Editing > Disable bookmark editing
- Google Translate > Never offer translation
- Developer Tools > Never allow use of built-in developer tools
- Form Auto-fill > Never auto-fill forms
- DNS Pre-fetching > Never pre-fetch DNS
- Multiple Sign-In Access > Block multiple sign-in access for users
- Search Suggest > Never allow users to use Search Suggest
- External Storage Devices > Disallow external storage devices
- Audio Output > Disable audio output

When the exam is finished, you can use the Google Apps Manager (GAM) command to erase any docs left in the account with the following command:

gam user ltchseam001(at)rdpsd.ab.ca show filelist | gam csv - gam user ~Owner delete drivefile ~alternateLink purge
STEP 2: Create Exam Template

Below is an exam template that has the ID#, current page and total pages in the footer, and is double-spaced formatted. If desired, it is possible to create an alternate template by replacing the “edit” at the end of the document address with “copy” to force a copy on a new user. The following link points to a Red Deer Public example (feel free to modify and use):
https://docs.google.com/document/d/1FOFVh5oWt7mvTKrhelUGjG0kFoyFrMfWPeHE9xEmPw8/copy

**This link needs to be added in the user settings as the homepage and pages to load on startup. The added bookmark (exam recovery) allows the student access to the Drive if the device fails, loses power, etc.
STEP 3: Create Exam Users and Apply to Exam OU

- Create a new OU for all exam user accounts (Google Exams) and then separate them by school.
- Create exam accounts using a naming protocol that identifies the school and reflects that it is an exam account (i.e., ltchsexam001(at)rdpsd.ab.ca for Lindsay Thurber, hhhsexam001(at)rdpsd.ab.ca for Hunting Hills, etc).
- Associate the accounts with the appropriate OU’s.
- Create Google spreadsheets for each school with the appropriate usernames and passwords. Teachers will be responsible for cutting these up and giving each student the username and password at the beginning of the exam (similar to Quest A+).

STEP 4: Set Up Google Cloud Printers Via Print Server Application

One method of setting up cloud printers is to purchase and install the professional edition of Cloud Print for Windows which installs a program on the print server that acts as an interface between Google Cloud and the Windows networked printers.

- Install a version of this application on each print server in the domain.
- Create a Google account for each location that would associate or manage the specific printers for that location.
- Share the printers with managers at each school location and let them determine an implementation method that best meets their specific needs (see the two Google Cloud printing methods below).

Features include:

- very quick and easy setup
- once setup, connection to the cloud is automatic and in the case of the server shutting down, restarts automatically
- no dedicated PC is required as everything is done on the print server.

Exam implementation:

- Specific printers were shared with the exam accounts so they would appear automatically for the user.

Google Cloud Printing Methods:

1. Share the printer privately with users (similar to how you share Google Docs)
2. Set up the printer as a public printer (within your domain) then limit the number of copies a student could make in any given day.
STEP 5: Add a Custom App to block the Research Pane

The research pane in Google Docs must be blocked as it allows students to retrieve information from the internet (see screenshot on the right). Chinook’s Edge School Division has created and published a Chrome Extension that “hides” the research pane. Essentially, the extension covers the research pane area which also means the “Define” menu will also be covered (and inaccessible). It is recommended that a dictionary extension be installed to address this issue.

The Hide Google Docs Research extension is publicly available at no cost to all school authorities who want to employ the use administer their Diploma OS devices.

Install the Chrome extension using one of the two methods listed below:
- Search through the Chrome web store (top left option)
- Specify the custom (bottom left option) using the credentials below:
  ID: fnfdkgkgcjiiahoknjoajgppboaobj
  URL: https://chrome.google.com/webstore/detail/hide-research/fnfdkgkgcjiiahoknjoajgppboaobj

Version 1.0 – May 2016
Sharing to the Exam Accounts
Currently, a way to limit users from receiving internally shared files has not been identified. This means a student could share a Google Doc with the exam account(s) and it would appear in Shared with Me. This vulnerability is acceptable as:

- Any shared file would be associated with the student account and would instantly be traceable back to that specific account. Sharing from external domains has been deactivated.
- Exam proctors/supervisors would need to check the shared folder before, during and after the exam. As the exam logins/user accounts would not be known by the students until the moment of the exam, the only conceivable way to communicate during the exam would be to share the document with all of the exam accounts. Proctors/administrators could easily login to multiple exam accounts at random to see if anything had been shared.

For more information on topics such as assistive technology for the purpose of accommodations, administering assessments in French and/or general questions please contact:

Pascal Couture
Team Leader, Digital Systems and Services
Provincial Assessment Sector
Phone 780-492-1462
Email: Pascal.Couture@gov.ab.ca